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Introduction
At Pearson, we understand the challenges of teaching with a new technology. For face-to-face, online,
hybrid, modular, or other course delivery methods, this all-inclusive User Guide will help to ensure a
successful teaching and learning experience.
Use this guide as a self-paced training course or click right to your topic of choice for just-in-time
answers. This searchable, interactive guide includes:
• Step-by-step instructions illustrated with screen grabs
•E
 mbedded training videos covering a variety of topics, from initial registration and login to posting
final grades
• Teaching tips from instructors currently using the product in their course
• First-semester implementation suggestions
…And much more!

This User Guide is available to you 24/7, as often as needed, throughout your course. So come back
often!

The My Education Community

First Day of Class Resources
Pearson provides the First Day of Class Resources that will help you get your students up and
running quickly with MyEducationLab.

At our Support Home Page, you and your students can access phone support, 24/7 chat and
email support, and an extensive, searchable knowledge base with how-to articles.

The Student
Experience

*Also accessible from mobile devices.

Gradebook

24/7 Customer Support

Assignments

Connect anytime with Business educators and members of the Pearson Faculty Advisory
Network—a network of educators teaching with technology using MyLab / Mastering—via the
My Education Community site for advice, best practices, and ongoing support.

Navigation

Dozens of regularly scheduled, live training sessions help you get the most out of
MyEducationLab. Virtual Classroom sessions are offered year-round, and you can attend as
many sessions as you need. Sessions are recorded so you can review them later and/or share
them with a colleague.
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Virtual Classroom Sessions Led by an Experienced User

Registration

All of the resources outlined below can be accessed at http://www.myeducationlab.com/
training and at http://www.myeducationcommunity.com/. You’ll find:

Course
Management
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Registration

How do I get started?
Request your instructor access code
You must have an instructor access code to get started. If you don’t have one, you can request one
online. Click here for the MyLab / Mastering home page, then click Educator under Register.
Under Request a Code, select your location, and provide the information requested. We’ll verify your
request and email your single-use access code within four business days of request approval.
Or, you can contact your sales representative to obtain an access code.
Order textbooks and student access code kits
Students need to redeem the individual, course-specific student access code to register for your online
course. This code can be redeemed only once — at the moment of registration.
Your bookstore needs to use the correct ISBN(s) when ordering. For most courses, they can order one
or both of the following:
• The textbook bundled with a student access card
• A standalone access code kit: MyLab Access
•A
 dditional book and code bundles are available. Ask your sales rep for the best combination for
your needs.
Your students can also pay online during registration. If they chose to use a credit card or PayPal
account to pay during registration, they don’t need an access code.
If your course has multiple student ISBNs representing different packages or print formats, your sales
representative can help you identify the correct ISBN(s) for your course.
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Register
1. On the MyLab and Mastering home page, click Educator under Register.
2. O
 n the Educator screen, click the Register button if you have an access code or click Request a
Code if you need to obtain one.
3. Read the license agreement and click I Accept to continue.
4. Sign in or create an account:
-C
 lick Yes under Do You Have a Pearson Education Account to sign in with your existing
Pearson account login name and password.
-C
 lick No to create a Pearson account. Enter a login name and password. Click Check
Availability to verify the new login name is available for use.
- Click Not Sure to search for your account.
5. E
 nter your access code in the boxes provided or click Switch to a single box to paste in the
access code.
6. Enter or verify your contact information.
7. F
 rom the Confirmation page, click Login to go to the MyLab / Mastering home page. In the
MyLab / Mastering New Design section on the left side of the page, click Create your New
Course to set up the course section(s) you will be teaching. See Creating Your New Design
Course for more information.
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MyLab / Mastering Account Home Page
After you log in you will come to your MyLab / Mastering Courses page. This page is the central
location for all of your MyLab / Mastering courses and Pearson resources. You will create your new
MyEducationLab courses here and access your other MyLab courses if applicable.
There are four areas on this page:
1.	
MyLab / Mastering New Design: Lists all the MyLab / Mastering New Design courses you are
teaching and where you will create your New Design courses.
2.	
Your Courses & Products: To access any of non-New Design MyLab courses, click the
applicable link in this area.
3. Announcements: Displays general announcements from Pearson Education and provides timely
information about each of your courses.
4.	
Need Help? Provides links to resources to help you Get Started, Access Support and Access
Pearson Resources.
The top right corner of the MyLab / Mastering Courses page provides links to:
• Account: Enables you to manage your Pearson account by editing your personal information.
•H
 elp & Support: Opens a page with links to online Instructor or Student Help and MyLab /
Mastering New Design support resources.
• Sign Out: Ends your session.

K eys f or Suc c ess: Logging out prevents the next user of the computer from accessing
a

your MyLab / Mastering New Design instructor resources, such as the Gradebook. This is
especially important if you are using a public computer, such as in a computer lab or shared
office environment.
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Course Set-up

Creating Your New Design Course
From your MyLab / Mastering Courses page you will create your course sections. You will be able to
create standard courses you can copy and you can also allow for other instructors to copy your course.
There are two types of courses you can choose:
• Generic Version (course specific with no eText, chapter study plans, or chapter testbank
assignments)
• Study Plan Version (course specific including the eText, chapter study plans, and chapter testbank
assignments)

H Best Practice: Setting up a separate course ID for each section of the course that you are teaching
will make managing your gradebook and due dates much easier. See Copy Additional Courses for
more information.

To create your MyEducationLab New Design course:
1. Click Create your New Course or Create/Copy Course located in the MyLab / Mastering New
Design area.
2. On the Create or Copy a Course page, search for course materials:
3. Select Search Course Materials. Enter the textbook Author, Title or ISBN to search for the Study
Plan course version.
OR
S
 elect Browse by Discipline. Click the dropdown menu to locate your discipline for the generic
course version and/or the Study Plan version. You can leave All Publishers selected or narrow your
search by selecting a specific imprint.
4. Click Go. Review the contents listed under the titles for the types of content included in the course
material.
5. Click Select Course Materials.
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To specify course information:
1. Enter the Course Name.
2. ( Optional) Enter a course Description to help distinguish this course from another course, for
example, the course number and section, or when the course meets.
3. Select a course type:
• For standard courses, in most cases you will select For Student Enrollment.
•S
 elect For Instructor Use Only for Coordinator courses or for standard courses if you do not
intend to enroll students in the course. This type of course can be modified and copied to create other courses. (If you are creating a For Instructor Use Only course, the Course Enrollment
Dates section is grayed out. Skip to step 5.)
4. Select Course Enrollment Dates:
•F
 or Enrollment Start Date, click the calendar icon to select the month, day, and year when you
want students to start enrolling in your course.
•F
 or Enrollment End Date, click the calendar to select the month, day, and year when you want
students to stop enrolling in your course.

H Best Practice: To reduce the likelihood of duplicate student enrollments, set the enrollment end
date to align with your school’s drop/add period, or other class start period. The enrollment end
date can be revised for late student enrollment, if necessary.
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5. Select Course Duration Dates:
•F
 or Course Start Date, use the calendar to select the month, day, and year when you plan to
begin teaching the course. The default is the current date.
•F
 or Course End Date, use the calendar to select the month, day, and year when you want to
close student access to your course. Students will be unable to access this course beyond the
maximum course end date of 24 months after creation. As an instructor, however, you will
have access to the course until it is deleted.
When the course reaches its maximum end date, it enters a 3-month course retirement phase.
At the end of this phase, email alerts remind you that your course is flagged for deletion, and provide
information on how to make a copy of your course for reuse after the original course is deleted. See
Course Expiration for more information.

H Best Practice: Leave the course start date default for the current date and set the course end

date a month or so after the last day of classes to allow students time to complete makeup work,
or to allow you time to copy course materials you plan to use again.

6. Under Make Available For Other Instructors To Copy, select:
• Available For Copy to allow other instructors to copy your course.
• Unavailable For Copy if you do not want other instructors to be able to copy your course.
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7. Click Create Course Now.

A Confirmation-Request Received page will provide you with your unique Course ID, usually
consisting of your last name and five numbers (for ex: smith12345). Course IDs also appear below
each course name in the MyLab / Mastering New Design courses list on the courses page. You can
print this page for your records. At the bottom of the page, click Back to your Courses page.
On your MyLab / Mastering Courses page the clock icon indicates that your course is being prepared.
When your course is ready you will receive an email. The course is created in as little as an hour or
up to one day, depending on the size of the course materials you selected and the number of course
creation requests in the queue. You do not need to stay signed in or be connected to the Internet while
your course is created.
You will receive an email when you course is ready. Included in this email is a student registration
handout populated with your course information including the Course ID that you can email or give to
your students. You can also access this handout by clicking the Details link next to your course name
on the courses list on your account home page.
After your course is created, you can communicate the course ID and student registration handout to
students so they can enroll in your course (for courses set for Student Enrollment).

K eys f or Suc c ess:
a
Do Not Give Students a Course ID until the Course Creation is Confirmed
Student attempts to register for a Course ID not yet completed will result in failed registration. Wait
until you receive the course confirmation email to start the registration process.
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Program Administrators and Coordinators
Program Administrators and Coordinators often have different needs and objectives than an individual
instructor. If you are a program administrator or coordinator creating courses for other instructors, you
have a choice between creating all of the course sections for every instructor in your own account and
creating one standard individual course with copy settings set to “available to copy.” Read below to
understand which option might better suit your needs.
Create All Sections in your Own Account
Choosing to create all of the sections in your own account allows you the ability to monitor and
analyze results from all sections of the course. Both you and the section instructors will have access
to the course as an instructor, but section instructors will not have access to the course roster unless
you enable that privilege when you upgrade their role. This option is the best choice for administrators
and coordinators that need to monitor and analyze results from all courses.
In this scenario, you would create a standard course, set up the course and finalize your customizations and organization, and then create multiple copies for each section being taught using the
Make Multiple Sections or Copies of a Course feature.
Once the sections are created, you can divvy out the corresponding course IDs to each instructor.
See Section Instructors/Teaching Assistants for instructions to enable the instructors’ access to
these section course IDs.

H Best Practice: When creating multiple copies of your course at one time, name the courses with
identifiers such as the instructors’ last names or the meeting days/time for the course.

Standard Course Set To “Available To Copy”
Choosing to create a standard course for your instructors to copy is fast and easy, but you lose the
ability to monitor each section. This option is the best choice for administrators and coordinators that
are only responsible for course set up and do not have a need to monitor and analyze results from all
sections.
In this scenario, you would create a standard course and set the copy settings to “available to copy,”
set up the course and finalize your customizations and organization, and then simply give each
instructor the course ID to make a copy of this course in their own instructor account. See
Create/Copy Additional Courses and Sections for instructions.
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Accessing Your Course
When you have received the email indicating that your course is ready, you may access your course.
1. Go to www.pearsonmylabandmastering.com.
2. Click Sign In.
3. Enter your login name and password.
4. Click Sign In.
To enter your course, click on the course name listed in the MyLab / Mastering New Design courses list.
You can review the course contents and add or delete materials to suit your needs. The course
becomes available for student enrollment on the date you set during course creation.
Click Details to confirm that the dates you set for your course are correct and to update course
information. You can change the course start and end dates, as well as the enrollment start and end
dates, at any time.

Note: Your course has an expiration date that is 24 months after the creation date. The end date you
set cannot be later than this expiration date. At the end of a 3-month retirement phase that follows the
expiration date, you receive emails alerting you that your course is flagged for deletion.
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Enable Students to Access your Course
To allow students access to your course:
1. G
 ive students the course ID when the course or section is ready.
Note: Students must enter the course ID when they register and enroll in your course. Course IDs are
typically formatted with your last name followed by 5 digits (i.e. smith12345). They are also case
sensitive and must be entered exactly as they appear on your courses list.
2. P
 rovide students with the Student Registration Handout that was included in your course creation
confirmation email or printed from the Details link in the courses list. And, refer students to the
First Day of Class (FDOC) material found on the First Day of Class website:
www.firstdayofclass.com: Step-by-Step Registration Presentation (PowerPoint®)

H Best Practice: Show the FDOC materials during class time to ensure that students follow all neces-

sary steps to successfully register and enroll in your course. This will also help to reduce the amount
of questions you receive from students regarding registration!

How Students Register
The student registration process is similar to instructor registration, except that students must provide
the course ID and purchase access.
From www.pearsonmylabandmastering.com students can register and sign in. Students can find
tours to get started and other support resources on the support tab of the www.MyEducationLab.
com website.
In addition to the FDOC materials referenced above, student registration instructions also appear in the
Student Access Kits that students receive when they purchase a new textbook package or the access
kit independently in the bookstore.
Temporary Access Option
For some courses, students can access the full set of features in your course without payment for 17
days. The Temporary Access option enables students waiting for financial aid to start coursework and
avoid missing deadlines you set. Students will receive alerts via email indicating how much time is left
until the temporary access expires. Students can change temporary access to fully active status at any
time by entering purchase information.
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Edit Course Details
After you have created a course, you might find that you need to edit some aspect of your course later
in the term. You can easily do things such as:
•

Rename your course

•

Add/delete/or edit the course description

•

Change the course type (For Student Enrollment or Instructor Use Only)

•

Edit the course enrollment start and/or end dates

•

Edit the course start and/or end dates

•

Change the copy settings (available or unavailable to copy)

To edit course settings:
From the MyLab/Mastering New Design courses list:
1. Click the Details link next to the right of the course name.
2. On the Course Details page, click Course Settings.
3. C
 lick on the Course Name and Description link OR the Course Dates, Type and Copy
Settings link.
4. Make any edits and click Save.
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Delete a Course
You can delete any course that you created as an instructor. Keep in mind that you have two options
to remove a course from your MyLab / Mastering New Design courses list: permanently delete or hide
from course display.

H Best Practice: If you created a course by mistake, “practice course” or duplicate that you no longer
need, deleting the course is the recommended action. However, if you just want to clean up your
courses list to remove older courses from view, hiding the course from the Account Homepage is
recommended.

To delete a course:
From the MyLab / Mastering New Design courses list:
1. Click the Details link next to the right of the course name
2. On the Course Details page, click Delete Course.
3. W
 hen the confirmation dialog appears, click Delete to permanently delete your course, or
click Cancel.
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Navigation

Where do I go from here?
Navigating the Course Menu
The Course menu appears on the left side of the Course window, making the tasks you perform
regularly more accessible. Use the Modify button above the Course Menu to add, rearrange, style,
and hide menu items in your course menu.
Use the arrow icons to expand to full screen or collapse for easier viewing. The course settings link below the course title allows you to manage your course roster and course files.
Course Menu buttons include:
•C
 ourse Home opens the Course Home page, where you can view your class announcements and
link to upcoming assignments. See Course Home for more information.
- About this course: Gives a brief description of course content.
- Syllabus: Allows you to upload an existing syllabus from Microsoft® Word® format or add
syllabus items manually. See Creating Your Syllabus for more information.
•A
 ssignment Calendar helps you and your students keep track of when assignments are due and
when assessments are available. Users can choose to see assignments organized in a List, Month,
or Term view. See Assignment Calendar for more information.
•G
 radebook shows students their results on assigned work as well as their overall score. They can
also review assignments from this page. See Gradebook for more information.
•P
 erformance enables you to track performance by Class Overview, Outcomes Summary, Outcomes by Student, and Outcomes by Activity. See Performance for more information.
•S
 ubmissions houses uploaded files from student submission assignments. You can review the
submission and comment back to the student directly. See Submissions for more information.
•e
 Text (available in applicable courses) allows you to search, highlight, and take notes that you
can view privately or share with students. See Utilize the eText to learn more.
Note: Your Pearson eText is also available on the iPad. Click here for more information and link to
the iPad App.
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•C
 ourse Content is organized by topic and divided by learning outcome and contains a study plan
for every chapter (if applicable). See Assignments for more details.
• Chapter Tests (available in applicable courses) offer additional chapter tests (both multiple
choice and essay) to assess your students’ understanding of chapter content.
• Course Resources are additional discipline specific student materials that are not book specific.
• Communicate (see Communicate for more details):
- Email: Allows you to email the whole class or individual students. Students can also email you
and their classmates from within MyEducationLab.
-D
 ocument Sharing: Enables you to share documents by uploading and creating categories
to store them. Instructors and/or students can then browse your categories to download the
documents.
-C
 hat: Creates and hosts web-based chat sessions.
-C
 lassLive: Allows students to join a session in real time. You can show files and presentations
and even allow students to write in the file synchronously.
•D
 iscussion: Groups all class discussions in one place.
• Instructor Resources:
-C
 ourse Map: Download a course map that outlines the Learning Outcomes and Standards covered in each topic.
-C
 orrelation Guide: Download a table that connects chapter sections with appropriate assignable exercises in MyEducationLab. All exercises are also correlated to Learning Outcomes and
Standards.
-B
 ook Supplements: Download Powerpoints, Instructor Manuals, and other Instructor
supplements provided for your text.
- Instructor Media Library: Upload or record audio or video files to your course.
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Course Home
Course Home is the entry point for your course. This page includes a customizable course introduction
area, announcements, social feed, assignment notifications, and gradebook notifications.
Note: You can rename the Course Home and move any other menu item to the top of your course
menu to make that menu item your course entry point.
Course Home with Activity Hub
With the enhanced Course Home, you can also view course activity, keep in touch with the people in
your course, add article feeds, view upcoming due dates, and view submissions for review.

Activity Hub
Three categories are accessible through the Activity Hub:
• Activity: This feed acts as the course “wall” and can be used by you and students for discussion
posts and remarks. It displays posts in real time and all posts are viewable by everyone in the
course.
•P
 eople: This tab within the Social feed allows you to see which users are logged into the MyLab
at any given time.
•A
 rticles: You can add article feeds to share with your students.

Using the Course Home Manager
You can create Announcements and customize your Course Introduction using the Course Home Manager.
To access the Course Home Manager:
1. Click on Course Home from the course menu
2. Click modify and select Manage from the dropdown located at the top right of the page.
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Announcements
You can create your own course announcements to welcome students to your course, inform
students about new content and assignments, remind students of upcoming tests, post information
about course-related resources, and more. You can also include links to other content or items within
an announcement.
Note: Announcements are categorized as Unread and Read. Once you have opened an announcement,
it will move from Unread to Read. You can re-access any read items by clicking the Read button under
Announcements.
To create a new course announcement:
1. F
 rom the Course Home page, click modify and select Manage from the dropdown located at
the top right of the page.
2. Click Add Announcement at the top left of the Course Home Manager.
3. T
 ype a brief title in the Subject text box.
4. In the content editor, type your announcement, format the text, and add content.
5. S
 elect the Start and End Display Dates for your announcement by typing the date in the
text box or clicking the calendar date.
6. Click Add Announcement to post your announcement or click Cancel to return to the
Course Home Manager without saving.
The announcement will appear as unread at the top of the announcements from the Course Home page
during the display dates you indicated.

T ip: If you want the announcement to remain visible for the remainder of the course, you can use
E
the course end date as the end display date.
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Customizing the Course Introduction
You can customize the Course Introduction area of the Course Home page by adding your own text and
images.

To customize the Course Introduction:
1.	From the Course Home page, click modify and select Manage from the dropdown located at the
top right of the page.
2. Delete the current image in the Visual Editor under Course Introduction.
3.	Using the Visual and Plain Text Editor add your own image(s) and text. (You can insert
images already uploaded to a course folder or browse to upload a new image)
4. Click Save Changes.

Note: Make sure to save changes before toggling from the Visual Editor to Plain Text Editor.

Your custom Course Introduction will appear on the top of the Course Home Page.
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Creating Your Syllabus
Add your course syllabus so that it is easily accessible by students anytime. You can upload an existing
syllabus in Microsoft Word format or you can compose a syllabus using the Visual Editor tool.
Note: You cannot combine both methods of creating a syllabus. If you import your syllabus in
Microsoft® Word® format and then try to add syllabus items using the Visual Editor, your Word
document will be deleted. Likewise, if you create syllabus items using the Visual Editor and then
import a Word version of your syllabus, the composed syllabus will be deleted.
To create a syllabus:
1. Click Syllabus on the course menu.
2. Click modify and select Manage from the dropdown located at the top right of the page.
If you wish to add a syllabus in Word format:
1. Select Upload Microsoft Word Syllabus (.doc).
2. Click Add.
3. Click Choose File to select your Word document.
4. Click Upload & Convert File.
Your Word document will be uploaded in HTML format.
If you wish to compose your syllabus using the Visual Editor tool:
1. Select Compose Text Item (Visual Editor).
2. Type in the Title for the syllabus item you are adding.
3. Use the content editor to add and format each syllabus item.
4. Click Add Item or Cancel to discard your changes.
5. Repeat these steps for each syllabus item you want to add.
You can later edit, reorder or delete items in your syllabus by selecting them in the Syllabus Items
list.
Click Syllabus from the Course Menu to view the syllabus at any time.
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Utilizing the eText
The eText version of your textbook is a fantastic resource for you and your students. It enables you to
more thoroughly integrate the book into your course, and can be opened on a PC, Mac or by
using Pearson’s eText for iPad app. As an instructor you automatically have access to the eText
for your course if it is available for your course type.
Students will have access to the eText if applicable for the course type and:
• if during registration their access code included eText access
• if during registration they chose to purchase access that included the eText using a credit card or
PayPal account
Students will have two options to use the eText:
• Connecting to your eText Course ID
• Self Study eText
Connecting to your eText Course ID will allow students to see any notes or highlights you have shared
from your instructor eText. The self study option provides students will all of the features of the eText,
but will not allow them to see any notes or highlights you have shared.
When you click the eText link in your course for the first time, you’ll be required to provide course information to create your eText course.
1. Enter a Course title and section name (optional)
2. Set the Student Access Properties
3. Set the Public Access Properties
4. Click Create Course
Once you click the Create Course button, your eText will be assigned an eText Course ID. Provide this
ID to students to get connected with your instructor eText if desired. Click Go to eText to open the
eText and begin reading and working.
Note: The set up process is only required the first time you access the eText in your course. You will be
taken directly to your eText when you launch it each time thereafter.
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Navigating your eText and using the Notes Manager
Navigate through the chapters of your text through the left-hand navigation. The toolbar at the top of
the window controls the search feature, page scrolling, highlighting and note tools, zoom effects,
bookmarking, glossary (if available), and whiteboard view.
In addition to the search and highlight feature, your MyLab eText also allows you to take private or
public notes using the Notes Manager.
As you pin notes to your eText, you can indicate to share with students so that they can benefit from
your notes as they view their own eTexts. Yellow push pin icons represent private notes and green push
pin icons represent a shared note.
T ip: Sharing eText notes with students is a great way to point out important items for an
E
assessment or to provide additional examples to help your students understand concepts
presented in the text.

Sharing a note with students:
1.	Click on the Note Tool pushpin icon and then place it in the text where you’d like to place a note.
2. Place a checkmark in the “Share with students” box.
3. Click Save then Close. Your pushpin will change from yellow (private) to green (shared).
Click the arrow next to the pushpin icon and Open Notes Manager in order to view and edit all your
eText notes.

H Best Practice:If you’re covering a particular passage from the textbook during lecture and have

access to a projector screen or SmartBoard, open your eText to the Whiteboard View. You’ll have
the widest screen from which to view the material, and can use the drawing tools to write or draw
around text.
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Communicate
We have provided you with additional tools to make communicating and sharing materials with your
students easier.
•

Email

•

Document Sharing

•

Chat & ClassLive

•

Discussion

Email
Use the internal email feature to message your students directly within MyEducationLab. You can
choose to send a message to one, some, or all students and include attachments if desired.
Document Sharing
You and your students can share documents by uploading them with Document Sharing. Your students
will be able to download the documents you have uploaded and upload their own documents. You can
organize the documents you and your students share by setting up categories to store the uploaded
documents.
Note: Make sure that you create categories before uploading documents as you will not be able to
transfer documents from one category to another after the upload is complete.
To add new categories:
1. Click on Add Category.
2. Enter the Category Title.
3. Select an option in the Assign Category to drop-down menu.
4. Click Add Category or Save and Add Another Category to add more categories.
Note: You will have the option to hide material from your students when you upload it.
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To upload a document:
1. Under Categories, select the category to contain the uploaded document.
2. Click Upload Document.
3. Under Share file with, select Instructor Only to hide the uploaded document from your
students or select Entire Class to share the document with your students.
4. Click Choose File, select the file to be uploaded, and click Open.
5. I f the selected file is a zip file and you want it unzipped as part of the upload process,
select Unzip .ZIP file.
6. Enter a description and click Add Entry.
To download a document:
1. Select the category containing the documents, then select the documents you want to download.
2. Click Download Documents.
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Chat
You can lead an Elluminate® Live chatroom discussion with your students. You can type messages to
your students and they can type messages to you and to any other students who join the chatroom.
To add a chatroom:
1. Under Course Tools, click Chat & ClassLive.
2. Click Chat.
3. Click Add Chat.
4. Type a chatroom Name in the text box.
5. Add a description and select other options as applicable.
6. C
 lick Add Room to add your new menu item, or Cancel to discard your changes. You can also
click Save & Add Another Room to add more chatrooms.
To view or delete a chatroom log:
1. Click the Chat Logs icon in the Chat Logs column.
2. Click a Session Date to view a log, then click back to return to the Chat Logs list.
3. T
 o delete a Chat Log, click the Delete icon in the Delete column, then click Delete Room &
Chat Logs or Cancel.
To edit a chatroom:
1. Click the Edit icon in the Edit column.
2. Modify the chatroom information as necessary.
3. Click Save Changes or Cancel.
To join a chatroom:
1. Under Course Tools, click Chat & Class Live.
2. Click the chatroom name in the Chatrooms list.
You have now joined the chatroom.
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ClassLive
ClassLive is an interactive chat tool that allows you to communicate with your students in real time.
Place or draw objects on the whiteboard, share a software application from your computer, send and
receive graphed or plotted equations, participate in synchronous chat sessions with your students, and
work through complex problems one step at a time. ClassLive can be used with a group of students or
one on one.
The ClassLive tool is enabled by default. You can turn ClassLive on or off from the modify page.
Note: We recommend you Join ClassLive 5-10 minutes prior to the start of your session to set your
connection speed and ensure the session is up and running for your students.
To create and lead a ClassLive session:
1. Under Course Tools, click Chat & ClassLive.
2. Click ClassLive.
3. Click Lead Session. (Your students will click Join Session.)
You will be asked to run the Elluminate Live! software. Once the software is launched, read and accept
the license agreement and then select your connection speed.
You can use the Participant window, on the top left, to monitor participants and assign permissions
for live activities. The Participants panel provides you with an overview of what is happening within
the session.
In the Chat window, your students will be able to share messages with you and other participants.
•	You can load presentations, such as PowerPoint slides, by clicking the folder icon in the lower left
corner of the Whiteboard toolbar.
•

Select the Help menu in the Elluminate Live! window for further assistance.

•

To end the session, select File > Exit, or close the Elluminate Live! window.

Note: As a stand-alone tool, ClassLive includes a training page with video tutorials and additional
documentation provided by Elluminate, Inc.
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Discussion
Discussions allow your students to share ideas with you and each other. You can create your own
discussion topics and/or utilize the pre-loaded discussions set up in chapter folders under the Discussion tab in your course menu. Your students can respond to the topic as well as each other’s posts from
within each discussion topic. Discussions can also be referred to as threaded discussions since your
students’ lively responses form an intertwined thread.
Note: Unlike the Live Chat and ClassLive online classroom, discussions are asynchronous. Students
do not have to participate at the same time; instead, they add threads to the discussion at a time that
works for them.
To add a discussion topic:
1. Click the Discussion menu item (the content pane will display added discussion topics).
2. In the upper right hand corner, click Modify > Manage.
3. The Discussion Manager will open. Click Add Topic.
4. For Title, add the subject of your topic.
5. Use the content editor to describe the topic or pose questions to your students.
6. Click Add Topic.
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To manage your discussions, you can sort and filter responses, and mark them as unread.
To sort responses, click any column header in a discussion thread to sort responses according to that
label (i.e. click Author to sort the re¬sponses alphabetically by the students’ names).
To filter responses:
1. Click Show Options in a discussion thread to display additional fields.
2. N
 ext to Select, choose to select All, None, Unread, Read, or Inverse from the options
dropdown.
Note: Inverse clears selected responses and checks unselected responses.
3. Click View Selected to only view those responses that match your selection.
To mark a response as unread/read:
1. C
 lick the open envelope icon. To later mark the response as read, click the closed envelope
icon.
OR
2. Click Show Options > choose Select All, None, Unread, Read, or Inverse> Choose
Unread in the Mark selected as dropdown. To later mark the response as read, repeat the same
steps and choose Read in the Mark selected as dropdown.

Registration
Course Set-up
Navigation
Assignments
Gradebook
The Student
Experience
Course
Management

For more information, please visit www.myeducationlab.com.
Join Us Online! www.myeducationcommunity.com.

Design your course
You can customize your course to give your students an effective learning experience. Update your
course menu, hide items, add new items, and add your own content, including Microsoft® Office files,
Adobe® PDFs, images, and videos.
Use the course features and tools to create a comprehensive and engaging learning experience for your
students.
Modify Your Course Menu
To modify and manage your course menu, you’ll need to access the Modify Lightbox feature. By clicking Modify above the Course Menu, you’ll be able to access the following Lightbox tabs:
•

Settings

•

Add & Arrange

•

Restore

•

Style

Once open, you can resize the lightbox. The square icon
in the upper right corner of the lightbox
increases the size of the lightbox window. This allows you to see more items in the lightbox when you
have a long course menu.
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Settings Tab
The Settings tab allows you to edit an item name, hide an item, mark an item as gradable, and mark
an item as a submission.
Edit item name: You can edit an item name either on the Settings tab or the Add & Arrange tab.
1. Hover your mouse over the item name.
2. Click on the name. An edit icon (

) and a text box appears.

3. Type the new name.
4. Press Enter.
Hide item: Items can be hidden from student view. Any items that you want to remain in the course
menu, but not have students see or access, should be hidden.
1. In the hidden column, click the check box for to the item you want to hide.
2. The item is now hidden from student view.
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Mark item as gradable: You can use the lightbox to mark items as gradable. This will create a column
in the gradebook for this item.
1. In the gradable column, click the check box for to the item you want to to make gradable.
2. The item will now appear in the gradebook.
Note: be sure to assign a point value to the item. View the Gradebook section for important gradebook
recommendations.
eys f or Suc c ess:
a K

Only Mark Items You Want to Appear in the Gradebook as Gradable
Your MyLab will not currently prevent you from marking any tool or item as gradable—including the
gradebook, itself. Be sure that the items you select as gradable are items you want to appear as
columns in the gradebook.

Mark item as submission: You can use the lightbox to mark items as a submission. This will create a
“dropbox basket” in the Submissions tool.
1. In the submission column, click the check box for to the item you want to make a submission.
2. The item will now appear in the Submission tool.
Note: in most instances, a submission item will also be “gradable,” so you’ll also want to check the
Gradable box and assign a point value to the Submission item. View the Submissions section for more
information.
K eys f or Suc c ess: Only Mark Items You Want to Appear in the Submissions Tool as a
a

Submission
Your MyLab will not currently prevent you from marking any tool or item as a submission—including
the submissions tool, itself. Be sure that the items you select as submissions are items you want to
appear as “dropbox baskets” in the submissions tool.
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Add & Arrange Tab
The Add & Arrange tab allows you to add new items, edit item name, order items, and archive items
you no longer wish to have in the Course Menu.
Adding new items to your course is a great way to incorporate your own instructional material and
assignments. A drop-down list of item types appears when you choose to add an item to your course.
You can add the following:
•	Content Page: Creates a content page for you to edit. Once added, click modify > Manage
above the content pane to add text or images in the content editor.
•	Threaded Discussion: Creates a discussion where you add topics for your students to
respond to.
•

Uploaded Content: Lets you upload an Adobe PDF file, Microsoft Office file, HTML file, video, or
image, and associate it with the new menu item. After creating the menu item, navigate to it and
click modify > Upload MS Office File or modify > Upload Content (PDF, HTML, etc.) above
the content pane.

•	Gradebook-only Item: Adds an item to the gradebook. The item does not appear in the course
menu. For example, you may want to add a Class Participation, or Attendance score.
•	Assessment: Creates an assessment item in the course menu. Once added, click the new
assessment item in the course menu, and click modify > Manage above the content pane to
add questions and configure questions and exams.
•

Study Plan: Allows you to create custom study plans
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Add new item
You can add a new main-level item to the bottom of the course menu, or add a “child” item to an existing “parent” item.
Add main-level item
1. Either click the Add new item button
or
scroll to the bottom of the item list on the Add & Arrange tab and click
Add new item to main level link.
2. Select the appropriate item type.
3. Input a menu item name.
4. Select appropriate item settings (e.g., hidden item, etc.).
5. Click the Save button. The item will appear at the bottom of the course menu.
Add child item
1. Click the expand arrow (

) to the left of the parent item to expand it.

2. A link will appear: add new item to [parent item name].
3. Click the link.
4. Select the appropriate item type.
5. Input a menu item name.
6. Select appropriate item settings (e.g., hidden item, etc.).
7. Click the Save button. The item will appear within the parent item in the course menu.
Edit item name: You can edit an item name either in the Settings tab or the Add & Arrange tab.
1. Hover your mouse over the item name.
2. Click on the name. An edit icon (
3. Type the new name.
4. Press Enter.

) and a text box appears.
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Order item
Whether it’s to list the most important items in your course at the top of the course menu, or to
rearrange content to better match your syllabus, you can reorder the items in your course menu
however you like. Use the ordering feature’s up/down arrows or dynamic numbering to place items
where you want them.
1. In the order column, use either the numbered text boxes or the up/down arrows to order items.
2. T
 he numbered text boxes allow you to quickly bump an item’s order. For example, to move an
item in ninth position to first position, type the number “1” in the text box.
3. The up/down arrows will move the item one position, either up or down.
Child items can be added to parent items or otherwise ordered by clicking the expand arrow ( ) of the
parent item. This will dynamically change the numbering in the text boxes and it will change the order
in which the up/down arrows move items.
Archive an item
You can archive an item to remove it from the course menu. Unlike hiding an item from the students,
archiving will completely remove the item, streamlining your menu and removing items you do not feel
you’ll use during the term. Or, if you’ve added an item but wish to remove it, you must archive it in
order remove it from the menu.
1. I n the archive column, click the archive icon (
course menu.

) for to the item you want to remove from the

2. A
 rchiving an item won’t fully delete the item. It will move it to the Restore tab, where it can be
restored back to the course menu or fully deleted.
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Restore Tab
The Restore tab allows you to either restore an archived item to the course menu or fully delete it
from the course altogether.
Restore an item
1. I n the restore column, click the restore icon (
course menu.

) to add a previously archived item to the

2. T
 he item will be restored to the bottom of the course menu. You can reorder the item on the
Add & Arrange tab.
Delete an item
1. I n the delete column, click the delete icon (
menu.

) to add a previously archived item to the course

2. The item will be fully deleted from your course and will not be retrievable.
Style tab
The Style tab allows you to change the default color of the banner and course menu.
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4

Assignments

MyEducationLab contains a breadth and depth of course content that you can easily arrange and
assign to create a unique learning experience for your course. Use any or all of the following pre-loaded
content as assignments for your students.
Course Content
Course Content houses most of the assignable content and is organized in two sections: first by chapter
and then by topic and divided by learning outcome.
Divided by chapter (if applicable for your course type):
•

Study Plans (Pretest and Posttest) for each chapter

Divided by topic and organized by Learning Outcome:
•

A&A (Assignments and Activities) assignments

•

BTSD (Building Teaching Skills & Disposition) practice and quiz assignments

•

Learning Outcome Quiz

To help you decide which assets might be best suited for your course, we have provided an explanation
and helpful information for each item. To customize your course with only the items you wish to utilize
in your course, see Modify Course Menu for instructions.
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Study Plans (if applicable for your course type)
Do you want to hold your students accountable for the course material and ensure they are better
prepared for class? The Study Plans are highly recommended activities for your MyLab course. They
can be assigned to hold your students accountable for the material and can help prepare them for
chapter assessments, midterms and/or final exams. They consist of a Pretest, Personalized
Study Materials, and Posttest.
The customized study materials—with complete remediation activities—are generated based on
students’ results of a pretest and organized by learning objective. Study Plans tag incorrect questions
from the pretest to the appropriate textbook learning objective, helping students focus on the topics
they need help with.
Note: Disaggregated eText pages are available to all students in the Study Material, whether or not
they have full eText access!
After students complete the pretest and remediation for all learning objectives assigned in the study
material, they take a post-test to see the concepts they’ve mastered or the areas where they still may
need extra help. Students have one attempt at the pretest and posttest.
MyEducationLab reports the pretest and posttest study plan results to the gradebook. Based on these
scores, you can adapt course material to suit the needs of individual students or the entire class.

H Best Practice: Some instructors like to have students complete the chapter Study Plan before the
section is covered in class. This assures you that students are familiar with the material and ready
for your lecture (if you have a traditional lecture component).
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A&A (Assignments and Activities) Assignments
Assignments and Activities are mostly comprised of essay or short answer questions for your students.
Many of these assignments include a video or artifact for the student to view before answering questions. Since the student answers will be subjective, you will be required to manually assign a grade for
these activities.
MyEducationLab will provide you with feedback you can review from the gradebook which you can
choose to use for the student submission or you can create your own feedback to provide each student.
BTSD (Building Teaching Skills & Disposition) Practice and Quiz Assignments
The Building Teaching Skills & Disposition activities are divided so that students can practice a skill first
and then be assessed on the skill using the quiz.
The practice assignment is set up to provide the student with:
•

Concept/Skill Overview- Introduction and synopsis of the assignment

•

Practice I- video with short answer questions

•

Practice II- different video with the same short answer questions as Practice I

The quiz is set up to provide the student with:
•

Introduction

•

Video

•

Multiple Choice Quiz

Note: BTSD Practice Assignments are meant for remediation and therefore do not report to the
gradebook. The BTSD Quiz will automatically be recorded in the gradebook upon completion.
Learning Outcome Quiz
Each Learning Outcome is accompanied by a Learning Outcome Quiz. The quiz is multiple choice and
can be used to assess the students’ knowledge of each particular learning outcome. Quiz results will
automatically report to the gradebook.
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Create New Assessment
Whether it’s to free-up class time or give your students more opportunities to test themselves on
course concepts, you may want to administer additional homework, quizzes or tests you have created
already or by using the tools in MyEducationLab.
•

Assign chapter tests or quizzes using the built-in test bank

•

Create your own custom assignments

•

Or Import tests, quizzes or exams from Respondus or TestGen .zip files.

Chapter Tests
Your course menu provides a Chapter Tests item in all applicable course types to house testbank
questions for each chapter (both multiple choice and essay).
You can review, edit, or randomize the questions before setting the scheduling and configuration for
the assessment.
Note: The Chapter Tests menu item (along with all of its contents) is hidden by default. You will need
to customize, assign, and unhide any items that you want students to have access to in their course.
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Custom Assignments
To create an assessment, you must first add it as a menu item, then you will be able to add the
questions, schedule and configure it.
Add an Assessment menu item:
1. Click Modify above the course menu and click the Add tab.
2. For Menu Item Type, select Assessment.
3.	For Menu Item Name, enter the assessment name that you want to appear in the course
menu, such as “Midterm.”
4.	Click Item is Gradable so that student assessment results are immediately calculated and
entered into the gradebook when they complete the assessment. For Points, enter the number of
points you want to assign this assessment in the gradebook.
Note: If you leave Item as Gradable unchecked, you can create the assessment, but grades are not
calculated and entered into the gradebook.

H Best Practice: If you’re not sure at this point what the value will be, you can wait until later to

specify. You’ll want the point value to be the same as the total point value of the questions in the
assessment. You can later update the point value of the assessment by clicking Gradebook,
modify > Setup, and updating Points.
5. For Add to, select a location for the assessment.
6.	Select the Hide from students check box if you do not want the assessment to appear in your
students’ course menus.

Note: You can add an assessment before you’re ready for students to access it by hiding it from
students. Then you can go back to the Modify Course Menu tool and unhide it later.
7.	Click Save to add your new menu item, or Cancel to discard your changes. You can also click
Save and Add More Items to continue adding gradebook items.
8. Exit from Modify Course Menu.
9.	Click the assessment item in the course menu, then click Modify > Manage, to develop or
import your quiz or exam.
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Add Questions
Follow these steps to build your assessment from scratch, using questions you create within
MyEducationLab.
1. Click Add Section.
2. Enter a name for the new section.
3.	If you’d like to have MyEducationLab randomly select a certain number of questions from your
section, check the “Randomly select” check box.
•

Enter the number of questions to be included in the question pool for this section.

•	Enter the number of points for each item in the question pool. Any question in this pool
will need to have the same point value.
4. Click Update Section.
To add a question:
1. Click the add icon.
2.	Enter the number of points assigned to the question. You can edit the question later, if you want
to change the number of points assigned.
Note: if your question is part of a pool of randomly selected questions, you won’t be able to enter the
number of points because you already gave it a point value when creating your pool.
3. At the top of the question window(Add to Section) select the type of question:
•

True of False

•

Multiple Choice

•

Multiple Answer

•

Fill-in-the-Blank

•

Matching

•

Short Answer

•

Essay
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4. Enter the Question Text and specify the correct answer or answers.
5.	Click Add general feedback to provide information that students see after answering
the question.
6.	Click Add feedback to provide information to students for each answer choice of true/false,
multiple choice, and multiple answer questions.
7.	Click the check mark to the left of the correct answer for true/false, multiple choice, and
multiple answer questions.
8. Click Add Question.
Continue adding all of the questions and/or sections you need to finish your assessment.
Click Preview, then Begin Assessment to be able to experience taking the assessment.

Note: If you add an essay or short answer question to an assessment, you will need to manually
grade those questions. If students check their assessment scores before you enter the score for these
questions, they will see a “0” associated with any essay or short answer questions in their Gradebook.
This will result in an overall lower the score for the entire assessment. After you have reviewed and
manually entered points for these questions, student scores for the entire assessment will readjust to
reflect the total earned score.
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Import Tests/Exams from Respondus or TestGen (if applicable)
If you have assessment files already created in other test generating programs, MyEducationLab
allows you to import those existing questions. Then you can edit and rearrange any of the questions
that you’ve added.
You can import assessment packages created in TestGen or Respondus applications.
•	If using TestGen, be sure to use the Export > QTI (WebCT CE6, WebCT VISTA) option.
The import feature does not currently support native TestGen formats, such as .bok or .tif.
•	If using Respondus, be sure to use the IMS QTI 1.1+ personality for exporting your
assessment content.
The question types supported for import include true/false, multiple choice, multiple answer, short
answer, essay, fill-in-the-blank, and matching questions.
If you import assessment packages to an existing exam, the new questions are added to the beginning
of the exam. You can then rearrange sections and questions.
To import an assessment package:
1. Click your Assessment in the course menu.
Note: You must add an assessment before you can import an assessment package for that
assessment.
2. Click Modify > Import above the content pane.
3. Click Import.
4.	For Choose Assignment Package Type, select one of the supported assessment package
types. (Supported assessment packages include Respondus and TestGen)
5. For Select File, browse to select the .zip package to be imported.
6. Click Upload and Import File.
7. Click OK on the confirmation page.
8. You can import another assessment or click Status to monitor the progress of the import.
9. Click Modify > Manage to edit or preview your Assessment.

Registration
Course Set-up
Navigation
Assignments
Gradebook
The Student
Experience
Course
Management

For more information, please visit www.myeducationlab.com.
Join Us Online! www.myeducationcommunity.com.

Create a Submission Assignment
The Submissions tool is an online “dropbox” for communication between you and your students for this
type of assignment.
Note: There are no assignments automatically populated into MyEducationLab marked as this activity
type. You will only use this feature if you are creating and assigning your own Submission activities.
How does a Submission Assignment work?
1. Students complete the assignment and upload their document to the Submissions area.
2. You retrieve the assignment from your Submissions area, grade and comment, then return it.
3. When needed, you can coach a student by providing multiple responses to help clear areas of
confusion. Submissions are especially useful if you’d like students to submit multiple revisions of an
assignment.
4. After you finish reviewing each student’s submission, you enter the grade in the Gradebook.
Note: You can also find an alert of these submissions in the “For Review” list located on your Course
Home. The student submissions you haven’t yet reviewed display there.

Registration
Course Set-up
Navigation
Assignments
Gradebook
The Student
Experience
Course
Management

For more information, please visit www.myeducationlab.com.
Join Us Online! www.myeducationcommunity.com.

You can set up any assignment as a submission via the course menu.
To create a submission:
1. Click modify above the course menu and click Add & Arrange.
2. Click Add menu item or Add new item to main level to add a new item to the main level of the
course menu.
-T
 o nest a new item within another level of the course menu, click the expand icons and click
Add new item to… at the level you want.
3. For Select Item Type, select any item type.
- Any item type can be a submission.
4. Enter the Menu Item Name you want to appear in the course menu.
5. Click Allow Submissions if you want students to complete a submission for you to review.
- I f you don’t make an item a submission when you first create it, you can make it a submission
at any time. Click modify above the course menu, click Settings, and select the submissions
check box for the item.
6. Select the Hidden from Student check box if you do not want the item to appear in your students’ course menus.
- I f you hide the item from students, there will be no menu item for the submission, but students can click Submissions in the course menu to submit the assignment.
7. Click Save to add your new menu item, or Cancel to discard your changes.
8. Click Close.
9. Click the submission’s menu item, and click modify > Manage above the content pane to
add the content for the submission.
-Y
 ou can provide instructions for completing the assignment, as well as links to uploaded files if
they’re needed for the assignment.
-Y
 ou can also instruct students to click Submissions in their course menu when they’re ready
to submit the assignment for you to review.
- I f you want students to upload multiple files to complete an assignment, you can include that
in your instructions.
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To review submissions:
1. Click Submissions. (All submitted assignments display. A count indicates how many submissions
are awaiting your review.)
2. T
 o filter by a particular assignment, click Assignment and select the submission you’d like to
review.
3. For each student who has submitted the assignment, click an attached file.
Note: Students can upload multiple files within a submission.
4. You can provide feedback directly in the assignment by saving and editing the attached files.
5. After you review the assignment, click Comment & Return Assignment.
6. In Comments, enter your feedback.
7. I f you’ve edited a student’s assignment to provide feedback, click Attach a file and select the
file.
- Click Attach another file to include additional files with your feedback.
- Click Remove next to a file if you no longer want to include it with your feedback.
8. Click Comment & Return Assignment.
Note: Once you have reviewed all submissions for an assignment, the Submitted for Review list for
that assignment is empty.
9. For gradable submissions, enter the student’s grade in the gradebook.
Note: Click No Submission to view the students without submissions for the assignment or
Returned to view the submissions you’ve already reviewed for the assignment.
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Assigning Activities (Setting Due Dates and Parameters)
You can assign due dates to activities in your course in two ways:
•

Using the Assignment Calendar

•

Using the Schedule feature within the activity Assignment Manager

H Best Practice: Use both methods for each assignment. Use the Assignment Calendar to ensure

that your due dates appear in the student’s calendar view and the upcoming assignments area
on the Course Home page and use the Schedule feature to set availability windows and a review
date.

Adding due dates to the Assignment Calendar:
1. Click on Assignment Calendar from the course menu
2.	Click Modify and select Manage from the dropdown located at the top right of the page.
A Lightbox window will open and list all assignable items in the left hand menu.
3.	To set a due date for an item, the click on the assignment (in the left column of the Lightbox)
and then click on the desired due date.
4. The due date is set and a clock appears to the right of the content item.
Note: The clock only appears in this Lightbox, not next to the content item when accessed through
the course’s left navigation menu.
5.	When an activity is due within the upcoming week, an alert will show in the “Upcoming” area of
the Course Home.
To view assignments and their due dates on the Assignment Calendar, users can choose to see assignments organized in a List, Month, or Term view. To go into the past or future of the List and Month
views, click the arrows to the left and right of “Today”. Notice the arrows gray out at the beginning or
the end of the course so the calendar cannot go beyond the course dates.
Note: In List view items are listed with nesting information so you can see where the assignment
can be found in the course menu. In Month or Term view hover over the assignment to see nesting
information.
Assigning due dates using this calendar feature will add these dates to the student view calendar as
well as the Upcoming Assignments area on the Course Home page. To set availability windows, review
date, and other parameters- continue reading Using the Schedule and Configuration feature within the
activity Assignment Manager.
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Would you like to restrict the window of time an assessment is available? Or whether a student may
take it more than once? You can easily manage these settings using the Scheduling and Configuration
settings with the activity assignment manager.
Using the Schedule and Configuration feature within the activity Assignment Manager
If you want to limit when your students can access an assessment, you can set an availability
window on it. To set the availability window of an item, you will need to go into the specific
assessment’s Schedule settings.
You can also fine-tune the assessment experience for your students with options like setting a time
limit, allowing repeated exam attempts, customizing the exam display, and displaying scores
immediately for students.
Note: If you don’t schedule an assessment, it is available right away. You can also schedule a review
date for an assessment—the date when the assessment results become available to your students.
To schedule an assessment:
1. Click the assessment menu item, and click Manage Assessment.
2. Click Schedule above the assessment.
3. To set the availability of your assessment:
•	Click the calendar icon
for Available from to select the first date that students
can access the assessment.
•	Click the calendar icon
assessment.

for To to select the last day students can access the

4.	To set a review date when students can view their grades for this assessment, click the calendar
icon
for Review Date to select a date.
Note: To allow students to view feedback on the same day the assessment is first available, set Review
Date and Available from to the same date.
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5. Specify whether to display grades by selecting one of the following:
•

 isplay grade without answers on Review Date. Displays the students’ grade without
D
showing correct answers to missed questions.

•	Display grade with answers on Review Date. Displays the students’ grade and correct
answers to missed questions, as well as feedback.
6. Click Save.
7. At the confirmation prompt, click OK.
8. In the upper right, click (close) to hide the Schedule settings.
The assessment’s availability window will now be on the Assignment Calendar.
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To configure an assignment:
1. Click your Assessment menu item and click Manage Assessment.
2. Click Configuration above the assessment.
3. For Exam Features, click an option’s check box to enable it:
•	Student can take this exam multiple times. Clear this option to ensure that students
take the assessment only once.
Note: if a student can take the assessment multiple times, when it is retaken, the previous scores will
be completely deleted.
•	Set time limit: Enter a value for the number of minutes students have to complete the
assessment.
•	Save answers and end assessment when time limit is reached. Provide a firm
deadline for the assessment. Clear this option to allow students extra time to complete it.
•	Create assessment with multiple pages. You can choose to have one section per page
or one question per page.
4. For Results Features, select one of these options:
•	Display score to student and post to gradebook. This selection will provide
immediate results for students. Select this option when the assessment consists of all
auto-graded question types. This score does not include essay and short answer results.
•	Hide score from student and don’t post to gradebook. Results are not provided
immediately to students. Select this option when the assessment includes essay or other
manually-graded question types.
5. Click Save.
6. At the confirmation prompt, click OK.
7. In the upper right, click (close) to hide the Configuration block.
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Adding an Introduction to an Assignment
You can also add an introduction note to students on any assignment that will show up after the student clicks on the assignment menu item, but before launching the actual assignment.
To add an introduction note:
1. Click your Assessment menu item and click Manage Assessment.
2. Click Introduction above the assessment.
3. Enter the message in the text box
4. Click Save

H Best Practice: Use the introduction for not only instructions, but also suggestions, hints or

additional information that your students may find helpful as they are completing the assessment.
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Edit an Existing Assignment
You might decide that you want to use one of the activities or assignments loaded into your MyLab
course, but need to make changes like adding/deleting questions or changing the point value. You can
easily accomplish this by using the activities’ Assignment Manager and edit feature.
To edit an assignment, click the menu item of the assignment and click Manage Assessment.
•

Click the add icon in the main area to add a custom question to the assignment

•	Click the pencil icon in the main area to randomize the questions by pulling only a set number
of questions from the entire question pool at random
•	Click the pencil icon next to each question to edit the question, answer, feedback or point value
for each question
•

Click the “x” icon to remove the question from the assignment

•

Click the up/down arrows to move the order of each question

Edit the point value of an Assignment
See Gradebook Setup for instructions.
Reset or Add Additional Time on an Assignment
See Reset an Assessment and Add Additional Time for instructions.
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Gradebook

5

Your MyLab course offers you a full-functioning gradebook to manage all of your course grades in
one place. In addition to the grades that automatically populate into the gradebook, you can also
manipulate and modify individual student grades, mark assignments as extra credit, exclude assignments from students’ grades, export grades to your learning management system, add custom gradebook columns, and more.
How the Gradebook works
All gradable items in your course are represented by a gradebook column. As you customize your
courses content, you will notice a direct correlation of changes occurring in your gradebook.
Activities and assessments that are auto-graded by MyEducationLab will automatically record to the
Gradebook. Some assignments that are subjective in nature (short answer, discussion, or essay)
require manual grading. You can also manually grade other items you have identified as gradable or
gradebook-only items to add points for things like participation and attendance. There is also a Grade
to Date Column that will track each student’s cumulative percentage grade in the course.
Navigating your gradebook
Your gradebook has 3 main areas accessed by clicking on the modify link in the upper right hand corner
when your gradebook is opened.
•

Overview

•

Grade by Assignment

•

Setup

Overview
This is the main view of the gradebook that lists all active students and all gradable items in your
course. From this view, you can add or edit any individual grades including points, letter grade,
comments, and decide whether or not to share the grade with the student. You can also review the
student’s submission by clicking on View Details.
Note: After you have navigated to another view in the gradebook, you can always return to the main
Overview screen by clicking modify>Overview or by simply clicking on the Gradebook menu item again
in the left hand navigation.
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Grade By Assignment
The Grade by Assignment view provides a snapshot view of each students’ scores, letter grades,
comments, and submission details for each assignment individually.
To navigate to the Grade by Assignment view:
•

Click the modify link in the upper right hand corner of the content page

•

Choose Grade By Assignment

You can select any assignment listed in the gradebook from the dropdown above the grid of students
and scores. From here, you can add or edit any individual grades including points, letter grade,
comments, and decide whether or not to share the grade with the student. You can also review the
student’s submission by clicking on View Details. You can also navigate through the entire list of assignments by clicking the Previous Assignment and Next Assignment buttons at the bottom.
This is a great tool if you need to quickly assess your class results on a specific assignment or if you
need to add or edit grades for more than one student on the same assignment.
Setup
The Setup view includes only assignment information and does not include any student information. It
lists all assignments that are listed in the gradebook with the corresponding max point value of the assignment.
To navigate to the Setup view:
•

Click the modify link in the upper right hand corner of the content page

•

Choose Setup

From this view, you can edit the max points of any assignment, mark an assignment as extra credit, or
exclude an assignment from the students’ grades.
You can also choose to modify a gradebook item or add a new gradebook item by using the buttons at
the top of this view. The buttons will link you to the Modify Course Menu lightbox where you can make
changes and add items.
Note: You can also add and modify items by going directly to the Modify Course Menu lightbox from
any place in your course by clicking the modify link above the course menu.
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Add a gradebook item
1. Click Add New and the Modify Menu Lightbox will open to the Add & Arrange tab.
2.	Click Add new item to add an item to the main level OR expand the menu item where you want
the new item to reside (i.e. Course Content) and click the Add new item link.
3.	Select an item type from the dropdown. Any item type can be gradable. You can select
Assessment to create an exam with questions.
Note: You can select Gradebook-only Item to create a graded item that you don’t want included in
the course menu.
4. Enter the Menu Item Name you want to appear in the course menu.
5. Checkmark Gradable.
6. For Points, enter the number of points you’re assigning for the item.
Note: The point value will need to match the points associated with the actual assessment.
So be sure if you are adding questions that the total points in the created assessment match the max
points assigned here. (This can also be edited later in the gradebook Setup if needed)
7.	Click Submission if you want students to complete and submit the item to your Submissions
area for you to review.
8. Select the Hide from students check box if you do not want the item to be visible to students.
9. Click Save to add your new menu item, or Cancel to discard your changes.
10. Click the exit icon to close.
11. Your new gradebook item has been added to your gradebook and/or course menu if applicable.
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Modify Gradebook Items
This feature will allow you to mark or unmark any item as hidden, gradable, or submission. You can
use other features within your course to modify other aspects of the item.
1. Click Modify Gradebook Items and the Modify Menu Lightbox will open to the Settings tab.
2. Use the expand arrows to locate the assignment that needs modification.
3. Check or uncheck the boxes for hidden, gradable, or submission for any item.
4. Click the exit icon to close.
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Enter student grades
You can enter student grades in the gradebook from both the Gradebook Overview as well as the Grade
By Assignment view of the gradebook.

H Best Practice: Enter grades using the gradebook overview for a quick an easy way to enter a grade
for any student on any assignment. And use the grade by assignment view for the best way to enter
a group of grades for a single assignment.

You do not have to enter grades for assessments (quizzes and exams). As soon as students complete
the quiz or exam, the scores appear in your gradebook. However, if a quiz or exam includes essays
and/or short answer questions, you do need to grade these questions.
T ip: If you’d like to change a student’s score on an automatically graded assessment, for example
E
to give extra points or make a deduction, follow these same steps.

To enter student grades in the Gradebook Overview on a per student basis:
1. Click Gradebook in the course menu.
Your gradebook appears with the following columns:
•	Name: Lists student names alphabetically. The list of students is the same as the course
roster.
•	Grade to Date: Grade average. The grade to date is calculated by dividing the total
points earned by the points attempted.
Note: If a student has not yet completed an assignment, that score is not factored into the grade to
date.
•	Assignment columns: Each assessment and gradable item is shown in a column. The
number of possible points for each assignment is shown beneath the assignment name.
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2. In the row for a particular student, click the cell corresponding to a particular assignment.
3. Enter the number of points the student earned in the Points text box.
4. (Optional) You can also enter a letter grade in the Letter Grade text box.
Note: The letter grade you assign does not get factored into the grade to date. Only the point score is
factored into the grade to date.
5.	(Optional) Under Comments, type comments about the assignment. A student will see your
comments in the student gradebook.
6. Click Show to Student to share the grade and comments in the student’s view.
7. Click Save or click View Details to view and edit the assignment details.
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Export Student Grades
If you ever need your gradebook in spreadsheet form, you can Export your students’ grades from the
Gradebook. Exporting the grades will produce a CSV file which can be opened in Numbers for Mac or
Excel for PC.
1. Click Gradebook in the course menu.
2. Click the Export Gradebook button in the upper right corner of the gradebook page.
Open the CSV file to see students’ First Name, Last Name, Email Address, and Scores for each column
from your gradebook.
View Details of Student Submissions
You can view the details of a student’s submission from both the Gradebook Overview as well as the
Grade By Assignment view of the Gradebook. The details of the submission will allow you to review the
date taken, time spent on the assignment, number of questions, percentage and raw score earned, as
well as a breakdown of each of the questions and answers.
To review details from the Gradebook Overview:
1. Click Gradebook.
2. Locate the student and scroll to the activity column you wish to review
3. Left click on the dropdown next to the score earned
4. Click View Details.
To review details from the Grade by Assignment view:
5. Click Gradebook.
6. Click the right Modify and select Grade by Assignment.
7. Select the assessment you want to reset, from the drop-down list of assignments.
8. In the row of the student whose assessment needs reset, click Details View.
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Reset an Assessment
If you would like to allow a student to retake an assessment that you had configured for only one
attempt, you can reset the assessment.
To reset an assessment item:
1. Click Gradebook.
2. Click the right Modify and select Grade by Assignment.
3. Select the assessment you want to reset, from the drop-down list of assignments.
4. In the row of the student whose assessment needs reset, click Details View.
5. Click Reset Student Assessment under Details.
6. Click Continue to clear the student’s answers and results.
Note: Resetting an assessment will delete the previous submission and those results will be irretrievable.
Add Additional Time
If you need to allow additional time on an assignment on a per student basis, you can choose to add
additional time in one minute increments. Before you can add additional time for any student, the
student must launch and submit their first attempt. Once a submission is received, you will be able to
review the submission and add additional minutes at that time.
To grant additional minutes on an activity:
1. Click Gradebook.
2. Click the right Modify and select Grade by Assignment.
3. Select the assessment you want to reset, from the drop-down list of assignments.
4. In the row of the student whose assessment needs reset, click Details View.
5. Use the up and down arrows to adjust the additional minutes you wish to grant the student
6. Click Grant
7. Click Ok on the confirmation pop up
Note: This will allow the student back in to the entire assignment and they will have the ability to
change previous answers as well as answer incomplete ones.

H Best Practice: Use this feature to accommodate students who qualify for additional time on

assignments. Have the student use the initial allotted time and submit. Then add additional minutes
to extend the amount of time students have to complete the assignment.
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Performance
All of the assignments and assessments in your Mylab course are mapped to and aligned with
standards and discipline appropriate learning outcomes. With requirements to report on student performance on standards for accreditation purposes, the Performance feature can help you with easier
reporting.
With the advanced reporting capabilities, it creates detailed information on how students have
performed on exercises tied to learning outcomes and standards. This feature enables you to track
performance by Class Overview, Outcomes Summary, Assignment Details, and Student
Performance.
Students can easily see their progress throughout the course with the Student Performance view as
well. It provides them with a color coded view of all assignments completed with percentage grade.
Class Overview
This view gives you a quick look into all class activity and progress as a whole without having to navigate through the gradebook.
You will be able to track the class average of completed assignments with color coded score ranges
showing the number of students with an average grade in each grade band. Each grade band contains
a dropdown containing the student names for each category. You will also get a quick view of your top
performers and lowest score earners.
T ip: Use the Class Overview details prior to class to provide just-in-time teaching on topics that
E
students still need to master.

Outcomes Summary
This view provides a snapshot of how the class is performing by learning outcomes and standards.
You can review the how many students demonstrate mastery of these outcomes and expand to see
which students fall into each bucket.
Assignment Details
This view provides a detailed breakdown by assignment. Filter to any assignment to see a snapshot
and results for that activity.
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This view provides reporting on individual student performance by assignment. You will be able
to review a color coded view of all assignments completed with percentage grade on a student
by student basis.
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The Student Experience

Starting from the first day of registration through the final exam, it is likely that you will field
questions about your MyLab course from your students. To help you and your students get answers
quickly, we have compiled a list of frequently asked questions that you might hear from your students
as you progress through the term and provided answers. Questions and answers are categorized by
topic- First Day of Class (Registration and Enrollment), Course Content, and Technical Support.
First Day of Class (Registration and Enrollment)
Are there instructions for student registration?
Yes, Pearson provides First Day of Class (FDOC) Step-by-Step Registration Instructions for students
found on the Support tab of the Mylab homepage.
What is the Course ID?
One of the first things that the student is asked for in the registration process is the instructor course
ID. Your course ID is found below each course name in your MyLab / Mastering New Design courses list.
After I finished registering, I got a message that noted my registration was being processed.
Did I do something wrong?
No, during high traffic times, processing student registration can take longer. If students receive this
message at the end of registration, they should wait a few minutes, then try signing into their account
to make sure the course is listed.
How can I be sure that my computer is compatible with the MyLab course?
Students can check the System Requirements listed on the Support tab of the MyLab Home page.
Where can I find more information to learn how to use the MyLab in your course?
There is a student user guide that walks students through registration, course navigation, and getting
help found on the Support tab of the MyLab homepage.
I paid for MyLab access for this same book and edition last term, but dropped the course. Do
I have to repurchase access?
Students can enroll in additional course sections without additional payment, for the life of the edition,
as long as they already have a fully paid subscription for that particular book/author/edition. See the
student user guide where Additional Course Section Enrollment is covered for more information.

Assignments

I am not happy with my grade, how can I use MyEducationLab to help me better
prepare for tests?
There are several self-study tools available in the MyLab course meant for remediation that
students can use on their own. You can refer them to the Study Plans (not applicable in the
generic non-book specific courses) and eText (not applicable in the generic non-book specific
courses). See the student user guide where Using the Study Plans is covered for more
information.

Navigation

Course Content

Course Set-up

How can I convert my temporary access to fully paid access?
Students have 2 ways to convert temporary access to fully paid. They will receive three alerts
via email indicating the time left before the access expires. Students can click the link within
the email and redeem an access code or pay with credit card or PayPal. Students can also access
the payment screen directly from their account home page by clicking the “Pay or use an access
code now” link under the course title and information. See the student user guide where
temporary access is covered for more information.

Registration

I am waiting for my financial aid check before I can purchase MyLab access, but I
don’t want to miss any deadlines. What can I do?
Students can opt for Temporary Access during registration. This will give them access to your
course for 17 days without payment. See the student user guide where temporary access is
covered for more information.

How do I get the eText on my iPad?
Students can download the Pearson eText for iPad app and access the eText on iPad either online
or via download. The app provides many of the same features as the browser based eText such
as search capabilities, highlights, notes, and bookmarks. There is a link in the Course Content of
the course or click here for more information and the link to the App Store.

Gradebook

There are no study plans or eText available in my course. Can you make them
available for me?
There are 2 types of courses for MyEducationLab: Study Plan version (course-specific with eText
and study plans) and Generic version (course-specific without an eText or Study Plans). If you
have created a generic course-specific course, there are no study plans or eText available in
those courses. You would need to create Study Plan versions of the course to utilize these fea-
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tures.
After I submitted my essay assignment, I was automatically given a zero? Why?
Many assignments in MyEducationLab have objective based questions and are automatically graded.
Since essay answers are subjective and require your instructor to review and manually grade, the score
will remain a zero (as a placeholder) until your instructor reviews and inputs your earned score.
I am unable to click on the “Begin Assessment” button to start my assignment.
If you have set an availability window and due date and time for an assignment that has passed, the
students will not be able to click on the “Begin Assessment” button to start and submit an assignment.
You would need to extend the availability window end date and/or time to allow the student to begin
and submit the assignment. (Note: this cannot be done on a student by student basis—it has to be
changed at the entire assignment level)
I was in the middle of an activity and I lost internet connectivity and can’t get back into the
assignment. What can I do?
Each time a student launches an activity it uses up an attempt regardless if there was a successful
submission or not. If the student only had one attempt available, you can decide to reset an attempt
(by deleting an unsuccessful attempt).
I was not able to finish the assignment in the time allotted, can you extend the time
available so I can finish the activity?
Once a student launches an assignment, the time allotted starts to count down. If a student submits
the activity before it is complete, you have the option to add additional minutes to give the student
more time to complete the assignment. (Note: This will allow the student back in to the entire
assignment and they will have the ability to change previous answers as well as answer incomplete
ones)

If it turns out that a student purchased the incorrect course materials, students should contact
Pearson Customer Service for assistance with purchasing options and return policies.

Students should also make sure that the computer they are using meets the system requirements and can also run the home diagnostic tool kit on their machine to make sure it has
everything it needs to run efficiently with the MyLab course.

Assignments

I am receiving an error message, what should I do?
For immediate assistance, students should contact our 24/7 Customer Support to report the
exact error message received and the steps they are taking before the error message appears.
Technical support agents can help the student troubleshoot the issue.

Navigation

I can’t open one of the assignments, what do I do?
For immediate assistance, students should contact our 24/7 Customer Support to obtain help
getting access to the material they need.

Course Set-up

I can’t seem to get registered for your course, what can I do?
Your student’s issue may be related to the course materials purchased. For immediate assistance,
students should contact our 24/7 Customer Support to obtain help getting registered and
logged in.

Registration

Technical Support
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Course Management

Manage your Course Roster
The course roster allows you to see a list of all of the students that have registered and enrolled in your
course. It displays the student’s name, email address, current role, status, and temporary access status
(if applicable).
You can use the roster to view your full list of students, make a student inactive in your course, view a
student’s temporary access status, promote an individual to the role of Section Instructor/TA, and give
permission for the Section Instructor to access and edit the course roster. You can access your Course
Roster from two places:
From your Courses list on your Account Home page:
•

Locate the course you want to view

•

Under the Course ID, click the hyperlinked number next to “students enrolled”

From your Course Home page:
•

Click the Course Settings link under that course title

•

Choose Course Roster from the dropdown

•

Review and/or make any changes to Role or Status

•

Click Save when finished or Cancel
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Active/Inactive Status
When a student successfully registers and enrolls in your MyLab course, they are active. During the
add/drop period, you might have students that drop the course and need to be removed from your
MyLab course. Removing a student from your MyLab course is handled by changing the student
Status to Inactive in the course roster. This will remove the student from your gradebook and any
class averages.
Temporary Access Status
Students waiting on financial aid to make course material purchases can get temporary access to
your MyLab/Mastering course without payment for 17 days. All students that chose to gain temporary
access will have red text beneath the student’s name indicating the status of the temporary access in
the Course Roster.
There are two different states:
• Temporary Access Expiration Pending
• Temporary Access Expired
Temporary Access Expiration Pending:
• Red text is added beneath the student’s name notifying you of student’s temporary course access
and lists access expiration date.
• Student Role is un-editable, prohibiting any changes to student’s role for individuals currently in
temporary course access status.
Temporary Access Expired:
• Red text is added beneath the student’s name notifying you that temporary course access has expired and lists access expiration date.
• Entire row is disabled, prohibiting any changes to student’s role or status.
Note: Students can change temporary access to fully active status at any time by entering purchase
information.
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Section Instructors/TAs (Optional)
Whether you are enabling another instructor to act as the Section Instructor to your course or promoting a student to the role of Teaching Assistant (TA), you will need to obtain a student access code for
them. They will enroll as students, then you promote them to section instructors from the course roster. When you update the role to Section Instructor, you will also have the option to grant them permission to access and edit the Course Roster.
You can obtain student access codes for section instructors from your sales representative or from
Pearson Technical Support.
Note: The role Section Instructor is used synonymously for Teaching Assistant in the Course Roster
Enable section instructors to access your course
You can allow one or more section instructors to access your course. You would use this option to add
co-instructors to your course or if you have set up courses in your own account to be taught by other
instructors (i.e. adjuncts).
Note: Only instructors can allow section instructors to access their courses—section instructors cannot
allow other section instructors to access courses unless you grant them permission to edit the course
roster.
Promote a student to the role of Teaching Assistant (Section Instructor)
You can promote one or more students to Teaching Assistant (Section Instructor), so they can help
you perform tasks. This could include creating assessments, managing the gradebook, or making other
modifications to your course.
Note: If the student registering as a teaching assistant is already enrolled in the course as a student,
he or she needs to register again with a NEW login name using another Student Access Code. In this
case, the teaching assistant will have a student login name and a teaching assistant login name.
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Manage Files
This feature offers you a repository for course documents and files. You can upload, download, and
organize materials by adding folders.
Note: This is an INSTRUCTOR ONLY feature. Students will not be able to view or download documents
or files you upload to this area. If you want to share material with students, you will use the Document
Sharing feature instead. Please click here for more information on Document Sharing.
To add new folders:
•

Click Add Folder

•

Enter Folder Name

•

Click Add Folder or Save & Add Another Folder

K eys f or Suc c ess:
a

Don’t add files to Master Folder that should reside in custom folders

You can upload files to the Master Folder, but if you want to organize your material using custom
folders, make sure that you create folders before uploading documents as you will not be able to
transfer documents from one category to another after the upload is complete.
To upload a file:
•

Click Upload Files

•

Click Browse, select the file to be uploaded, and click Open
-	If the selected file is a zip file and you want it unzipped as part of the upload process,
select Unzip .ZIP file.

•

Click Upload File

To download a file:
•

Click the checkbox next to the file(s) you wish to download, then click Download Files

Note: You can select one or multiple files at once. When choose multiple files, it will produce a .Zip file.
•

Open or Save the file(s)
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Create/Copy Additional Courses and Sections
You can create additional courses in a variety of ways. For example, you can browse or search for
course materials in the catalog like when you created your first course or copy an existing course from
your own account or another instructor’s account.
To create another course using the same course materials, you can:
•

Select the same textbook from the catalog to start from a fresh template

•

Copy an existing course that you created

•

Copy an existing course that another instructor created

Note: When you copy a course, the new course has a new course ID and an empty course roster and
gradebook.
To copy an existing course:
•

In the MyLab / Mastering New Design courses list, click Create/Copy Course.

•

Select Copy a Course.

•	Select Copy One of Your Existing Courses and select the course you want to copy from the
drop down menu.
•	OR Select Copy Another Instructor’s Course and enter the course ID (received from the
other instructor) of the course you want to copy.
•

Click Go.

•

Specify course information. (See Specify Course Information for more info)

•

Click Create Course Now

A Confirmation-Request Received page will provide you with your unique Course ID for your new
course. You can print this page for your records and click Back to your Courses page.
On your MyLab/Mastering Courses page the clock icon indicates that your course is being prepared.
When your course is ready you will receive an email.
Read further to learn why you might choose to copy courses!
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Copy a course you created
There are a few reasons that you might want to copy a course you created:
1. Accommodate all of the sections you are teaching in the same semester
Instructors teaching more than one section per term will need to create a standard course and
simply make copies to accommodate all sections they are teaching.
2. Copy a course from one semester to another when using the same book/edition
When using the same book/edition from one term to the next, you will most likely want to make a
copy of your current course to take advantage of the changes, organization, settings, etc that you
have already set.
Note: When you copy an existing course, your original course remains untouched. Assessments copied
with the course retain the same availability setting as in the original course.
Copy another instructor’s course
You may want to copy another instructor’s course if you are teaching a section of the same course or
planning to teach the same course at a later date. Copying another instructor’s course allows you to
take advantage of the changes, organization, etc that instructor already set up. After you copy the
course, you can customize it further.
Note: Assessments copied with the course retain the same availability setting as in the original course
set by the other instructor.
eys f or Suc c ess:
a K

Make sure the course you are attempting to copy has been made available

to copy

Before you can copy another instructor’s course, that instructor must make the course available for
copying and provide you with the course ID. If you try to copy a Course ID from another instructor that
is not marked “available for copy” in the course settings, you will receive an error. Click here to see
how to edit the copy settings of your course.
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Make multiple copies or sections of a course
You can make multiple copies of an existing course from your own course list at one time.
If you are acting as a coordinator or program administrator, you will need to create sections to
accommodate the sections you and others are teaching.
To make multiple copies or sections of a course:
•

In the MyLab / Mastering New Design courses list, click Create/Copy Course.

•

Select Make Multiple Copies or Sections of a Course.

•

From the list, select the course you want to copy and click Go.

•	In the Number of Courses box, enter the number of course copies you want to create and
click Update.
•

Edit the course and section names as needed.

•

You can change the Course Enrollment Dates and Course Duration for all copies.
-	After the course copies are created and appear in the MyLab / Mastering New Design
courses list, you can change the course dates (and other course settings) for each
individual course copy or section by clicking Details next to the course name.

•

When ready to create your copies, click Create Courses Now.
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Course Expiration
When you originally create your MyLab course, you set a course end date. As the course end date
nears, you will notice an hour glass icon next to your course title in the courses list indicating the
course is about to end. When you see this icon in your courses list, you have two options:
1.	If the course is still in use by registered students, you can extend the course end date up to a
maximum of 24 months from the course creation date (see instructions below). Once the 24
months are up, the course enters a 3-month retirement (inactive) phase, after which it is
removed from the system. If you have courses in the retirement process, you will receive three
consecutive email reminders, including instructions on how to preserve or export your course
materials.
2.	If the course has ended and there are no active student users, you do not need to take any
action. The course will automatically start the 3-month retirement phase 24 months after the
course creation date.
To extend the Course End date:
•

From the Courses list, click on the Details link to the right of the course title.

•

Click on Course Settings.

•

Click on Course Dates, Types, and Copy Settings.

•

Extend the Course End Date (no longer than 24 months after the Course Creation Date.)

•

Click Save.

Note: Once the 3-month retirement phase ends, the course will be automatically deleted along with all
assignments and student results.
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Retaining Course Content and Student Scores After Your Course Ends
During this 3-month retirement phase, your course remains in your MyLab / Mastering New Desigcourse list, so that you can manage what you’d like to do with the course and the gradebook content.
If you want to use the course as the basis for future classes, you can create a copy of it. All settings
and modifications will copy; only your gradebook and roster will not copy into the new course.

H Best Practice: During the copy process, you can elect “Instructor Use Only” for course type to

avoid course retirement and to act as a template to create your future “For Student Enrollment”
course sections. Instructor Use Only courses do not have a maximum course end date, so they are
not forced into retirement and can remain in your course list indefinitely.

To comply with your school’s retention policy, you may need to export your students’ grades (see
Export Grades for more information). If you plan to review and modify any gradebook submissions, or
manually grade assessments, you will need to complete this before exporting the records.
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